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Designers	and	artists	often	face	the	challenge	of	accurately	reproducing	colors	across	different	mediums	and	devices.	One	of	the	most	widely	used	color	systems	is	the	Pantone	color	matching	system,	which	provides	a	standardized	way	of	matching	colors.	In	the	context	of	Adobe	Illustrator,	finding	Pantone	colors	can	be	a	bit	tricky,	but	with	the	right
techniques	and	tools,	its	definitely	achievable.	In	this	comprehensive	guide,	well	walk	you	through	the	steps	to	find	Pantone	colors	in	Illustrator,	including	the	different	methods	and	tools	available,	and	provide	tips	and	tricks	to	help	you	master	the	process.Understanding	Pantone	Colors	and	Illustrator	Pantone	colors	are	a	specific	set	of	colors	that	are
defined	by	the	Pantone	Matching	System	(PMS),	which	is	widely	used	in	the	printing	industry.	Each	Pantone	color	has	a	unique	number	and	is	characterized	by	its	specific	hue,	saturation,	and	lightness.	In	Illustrator,	Pantone	colors	are	represented	as	a	special	type	of	color	called	a	Pantone	Color	or	Pantone	Solid	Coated	or	Pantone	Solid	Uncoated
color.	These	colors	are	created	using	a	specific	set	of	color	values	that	correspond	to	the	Pantone	color	number.To	find	Pantone	colors	in	Illustrator,	youll	need	to	have	a	good	understanding	of	the	Pantone	color	system	and	how	it	works.	Youll	also	need	to	know	how	to	use	the	different	tools	and	features	available	in	Illustrator	to	create	and	work	with
Pantone	colors.	In	this	section,	well	cover	the	basics	of	the	Pantone	color	system	and	how	it	relates	to	Illustrator.Pantone	Color	System	BasicsThe	Pantone	color	system	is	based	on	a	specific	set	of	color	values	that	are	defined	by	the	Pantone	Matching	System.	Each	Pantone	color	has	a	unique	number,	which	is	used	to	identify	the	color.	The	Pantone
color	system	includes	a	wide	range	of	colors,	including	solids,	pastels,	metallics,	and	fluorescents.	Each	color	has	a	specific	hue,	saturation,	and	lightness,	which	are	used	to	define	its	unique	characteristics.The	Pantone	color	system	is	widely	used	in	the	printing	industry,	as	it	provides	a	standardized	way	of	matching	colors.	In	Illustrator,	Pantone
colors	are	represented	as	a	special	type	of	color	called	a	Pantone	Color	or	Pantone	Solid	Coated	or	Pantone	Solid	Uncoated	color.	These	colors	are	created	using	a	specific	set	of	color	values	that	correspond	to	the	Pantone	color	number.	Pantone	Color	NumbersPantone	color	numbers	are	used	to	identify	specific	colors	in	the	Pantone	color	system.
Each	Pantone	color	number	corresponds	to	a	specific	set	of	color	values,	which	define	the	colors	hue,	saturation,	and	lightness.	Pantone	color	numbers	are	usually	represented	as	a	five-digit	number,	followed	by	a	letter	(e.g.,	2965C).	The	first	two	digits	represent	the	colors	hue,	the	next	two	digits	represent	the	colors	saturation,	and	the	final	digit
represents	the	colors	lightness.Working	with	Pantone	Colors	in	IllustratorTo	find	Pantone	colors	in	Illustrator,	youll	need	to	know	how	to	work	with	Pantone	colors	using	the	different	tools	and	features	available	in	the	program.	In	this	section,	well	cover	the	basics	of	working	with	Pantone	colors	in	Illustrator,	including	how	to	create	and	apply	Pantone
colors,	and	how	to	use	the	Pantone	color	picker.Creating	Pantone	Colors	in	IllustratorTo	create	a	Pantone	color	in	Illustrator,	youll	need	to	use	the	Pantone	color	picker.	To	access	the	Pantone	color	picker,	go	to	the	Color	panel	and	click	on	the	Pantone	button.	From	the	drop-down	menu,	select	Pantone	Solid	Coated	or	Pantone	Solid	Uncoated	to
create	a	Pantone	color.	You	can	then	enter	the	Pantone	color	number	in	the	Pantone	Color	Number	field,	and	click	OK	to	create	the	color.	Applying	Pantone	Colors	in	IllustratorTo	apply	a	Pantone	color	to	a	shape	or	object	in	Illustrator,	simply	select	the	shape	or	object	and	go	to	the	Color	panel.	Click	on	the	Pantone	button	and	select	the	Pantone
color	you	want	to	apply	from	the	drop-down	menu.	You	can	also	use	the	Pantone	color	picker	to	select	a	Pantone	color	and	apply	it	to	a	shape	or	object.	(See	Also:	Why	Is	My	Beard	Multiple	Colors?	The	Surprising	Answer)Pantone	Color	Picker	in	IllustratorThe	Pantone	color	picker	in	Illustrator	allows	you	to	select	a	Pantone	color	from	a	list	of
available	colors.	To	access	the	Pantone	color	picker,	go	to	the	Color	panel	and	click	on	the	Pantone	button.	From	the	drop-down	menu,	select	Pantone	Solid	Coated	or	Pantone	Solid	Uncoated	to	access	the	Pantone	color	picker.	You	can	then	select	a	Pantone	color	from	the	list	and	click	OK	to	apply	it	to	a	shape	or	object.Methods	for	Finding	Pantone
Colors	in	IllustratorThere	are	several	methods	for	finding	Pantone	colors	in	Illustrator,	including	using	the	Pantone	color	picker,	using	the	Pantone	color	book,	and	using	online	resources.	In	this	section,	well	cover	the	different	methods	for	finding	Pantone	colors	in	Illustrator.Using	the	Pantone	Color	PickerThe	Pantone	color	picker	in	Illustrator	allows
you	to	select	a	Pantone	color	from	a	list	of	available	colors.	To	access	the	Pantone	color	picker,	go	to	the	Color	panel	and	click	on	the	Pantone	button.	From	the	drop-down	menu,	select	Pantone	Solid	Coated	or	Pantone	Solid	Uncoated	to	access	the	Pantone	color	picker.	You	can	then	select	a	Pantone	color	from	the	list	and	click	OK	to	apply	it	to	a
shape	or	object.Using	the	Pantone	Color	BookThe	Pantone	color	book	is	a	physical	book	that	contains	a	list	of	Pantone	colors,	along	with	their	corresponding	color	values.	To	use	the	Pantone	color	book,	simply	look	up	the	Pantone	color	number	you	want	to	use	and	enter	the	corresponding	color	values	in	the	Color	panel	in	Illustrator.Using	Online
ResourcesThere	are	several	online	resources	available	that	can	help	you	find	Pantone	colors	in	Illustrator.	These	resources	include	Pantones	official	website,	which	provides	a	list	of	Pantone	colors	and	their	corresponding	color	values.	You	can	also	use	online	color	pickers,	such	as	Adobe	Color	or	Color	Hunt,	to	select	a	Pantone	color	and	get	its
corresponding	color	values.Using	Adobe	ColorAdobe	Color	is	a	free	online	color	picker	that	allows	you	to	select	a	Pantone	color	and	get	its	corresponding	color	values.	To	use	Adobe	Color,	simply	go	to	the	Adobe	Color	website	and	select	a	Pantone	color	from	the	list.	You	can	then	copy	and	paste	the	color	values	into	the	Color	panel	in	Illustrator.Using
Color	HuntColor	Hunt	is	another	online	color	picker	that	allows	you	to	select	a	Pantone	color	and	get	its	corresponding	color	values.	To	use	Color	Hunt,	simply	go	to	the	Color	Hunt	website	and	select	a	Pantone	color	from	the	list.	You	can	then	copy	and	paste	the	color	values	into	the	Color	panel	in	Illustrator.	(See	Also:	How	to	Fill	Excel	Rows	with
Alternate	Colors?	Easily)Tips	and	Tricks	for	Finding	Pantone	Colors	in	IllustratorHere	are	some	tips	and	tricks	for	finding	Pantone	colors	in	Illustrator:Use	the	Pantone	Color	PickerThe	Pantone	color	picker	in	Illustrator	is	a	powerful	tool	that	allows	you	to	select	a	Pantone	color	from	a	list	of	available	colors.	To	use	the	Pantone	color	picker,	go	to	the
Color	panel	and	click	on	the	Pantone	button.	From	the	drop-down	menu,	select	Pantone	Solid	Coated	or	Pantone	Solid	Uncoated	to	access	the	Pantone	color	picker.Use	the	Pantone	Color	BookThe	Pantone	color	book	is	a	physical	book	that	contains	a	list	of	Pantone	colors,	along	with	their	corresponding	color	values.	To	use	the	Pantone	color	book,
simply	look	up	the	Pantone	color	number	you	want	to	use	and	enter	the	corresponding	color	values	in	the	Color	panel	in	Illustrator.Use	Online	ResourcesThere	are	several	online	resources	available	that	can	help	you	find	Pantone	colors	in	Illustrator.	These	resources	include	Pantones	official	website,	which	provides	a	list	of	Pantone	colors	and	their
corresponding	color	values.	You	can	also	use	online	color	pickers,	such	as	Adobe	Color	or	Color	Hunt,	to	select	a	Pantone	color	and	get	its	corresponding	color	values.Use	the	Eyedropper	ToolThe	eyedropper	tool	in	Illustrator	allows	you	to	select	a	color	from	a	shape	or	object	and	get	its	corresponding	color	values.	To	use	the	eyedropper	tool,	simply
select	the	shape	or	object	and	go	to	the	Color	panel.	Click	on	the	Eyedropper	button	and	select	the	color	you	want	to	use.Recap	and	Key	PointsIn	this	comprehensive	guide,	weve	covered	the	different	methods	for	finding	Pantone	colors	in	Illustrator,	including	using	the	Pantone	color	picker,	using	the	Pantone	color	book,	and	using	online	resources.
Weve	also	covered	some	tips	and	tricks	for	finding	Pantone	colors	in	Illustrator,	including	using	the	Pantone	color	picker,	using	the	Pantone	color	book,	and	using	online	resources.Key	PointsHere	are	the	key	points	to	remember	when	finding	Pantone	colors	in	Illustrator:Use	the	Pantone	color	picker	to	select	a	Pantone	color	from	a	list	of	available
colors.Use	the	Pantone	color	book	to	look	up	Pantone	color	numbers	and	enter	the	corresponding	color	values	in	the	Color	panel	in	Illustrator.Use	online	resources,	such	as	Pantones	official	website	or	online	color	pickers	like	Adobe	Color	or	Color	Hunt,	to	select	a	Pantone	color	and	get	its	corresponding	color	values.Use	the	eyedropper	tool	to	select
a	color	from	a	shape	or	object	and	get	its	corresponding	color	values.Frequently	Asked	Questions	(FAQs)FAQsQ:	What	is	the	Pantone	color	system?A:	The	Pantone	color	system	is	a	standardized	way	of	matching	colors,	which	is	widely	used	in	the	printing	industry.	Each	Pantone	color	has	a	unique	number	and	is	characterized	by	its	specific	hue,
saturation,	and	lightness.	(See	Also:	How	Much	Are	Gameboy	Colors	Worth?	Collectors	Edition	Guide)Q:	How	do	I	create	a	Pantone	color	in	Illustrator?A:	To	create	a	Pantone	color	in	Illustrator,	go	to	the	Color	panel	and	click	on	the	Pantone	button.	From	the	drop-down	menu,	select	Pantone	Solid	Coated	or	Pantone	Solid	Uncoated	to	create	a	Pantone
color.	You	can	then	enter	the	Pantone	color	number	in	the	Pantone	Color	Number	field,	and	click	OK	to	create	the	color.Q:	How	do	I	apply	a	Pantone	color	to	a	shape	or	object	in	Illustrator?A:	To	apply	a	Pantone	color	to	a	shape	or	object	in	Illustrator,	simply	select	the	shape	or	object	and	go	to	the	Color	panel.	Click	on	the	Pantone	button	and	select
the	Pantone	color	you	want	to	apply	from	the	drop-down	menu.Q:	What	is	the	Pantone	color	picker	in	Illustrator?A:	The	Pantone	color	picker	in	Illustrator	is	a	powerful	tool	that	allows	you	to	select	a	Pantone	color	from	a	list	of	available	colors.	To	use	the	Pantone	color	picker,	go	to	the	Color	panel	and	click	on	the	Pantone	button.	From	the	drop-down
menu,	select	Pantone	Solid	Coated	or	Pantone	Solid	Uncoated	to	access	the	Pantone	color	picker.Q:	How	do	I	use	online	resources	to	find	Pantone	colors	in	Illustrator?A:	To	use	online	resources	to	find	Pantone	colors	in	Illustrator,	simply	go	to	the	website	of	the	online	resource	(such	as	Pantones	official	website	or	online	color	pickers	like	Adobe	Color
or	Color	Hunt)	and	select	a	Pantone	color	from	the	list.	You	can	then	copy	and	paste	the	color	values	into	the	Color	panel	in	Illustrator.	Although	most	of	the	projects	use	either	CMYK	or	RGB	mode,	they	are	not	always	enough.	What	if	you	want	to	use	Pantone	colors	for	products?	If	you	use	Adobe	Illustrator	for	fashion	design,	its	a	good	idea	to	have
the	Pantone	palettes	handy.	Normally	we	use	CMYK	color	mode	for	print.	Well,	more	specifically	printing	on	paper,	because	printing	on	other	materials	is	another	story.	Technically,	you	can	use	CMYK	or	RGB	to	print	on	products,	but	having	the	Pantone	colors	is	a	better	option.	In	this	article,	youll	learn	how	to	find	and	use	Pantone	colors	in	Adobe
Illustrator.	Note:	all	screenshots	are	taken	from	Adobe	Illustrator	CC	Mac	version.	Windows	or	other	versions	can	look	different.Since	August	2022,	Pantone	Color	Books	are	not	available	in	Illustrator	anymore.	So	if	you	want	to	find	the	Pantone	color	swatch,	you	do	need	to	get	the	older	version	of	Illustrator.	You	wont	be	able	to	choose	Pantone	as	a
color	mode,	but	you	can	find	it	in	the	Swatches	panel	or	when	you	recolor	artwork.	If	you	havent	opened	the	Swatches	panel	already,	go	to	Window	>	Swatches.	Click	on	the	hidden	menu	and	choose	Open	Swatch	Library	>	Color	Books	and	then	choose	one	of	the	Pantone	options.	Usually,	I	choose	Pantone+	CMYK	Coated	or	Pantone+	CMYK
Uncoated	depending	on	the	project.	Once	you	chose	an	option,	a	Pantone	panel	will	appear.	Now	you	can	apply	Pantone	colors	to	your	artwork.	If	youre	using	any	Illustrator	version	later	than	the	2023	update,	you	wont	see	the	Pantone	swatches	in	the	Color	Books	anymore.	In	this	case,	you	need	to	uninstall	your	current	Illustrator	version	from	Adobe
Creative	Cloud	and	download	the	older	version	of	Adobe	Illustrator.	From	there,	you	can	copy	the	Pantone	swatches	and	paste	them	into	your	current	version	folder.	Here	are	some	recommendations	from	Adobe,	including	the	detailed	steps	to	make	the	swatches	transfer:	Learn	about	the	Pantone	Plus	libraries	in	Illustrator.	Once	you	got	that	fixed,
you	can	follow	the	steps	below	to	use	Pantone	Colors	in	Illustrator.	Using	the	Pantone	colors	is	the	same	as	using	color	swatches.	All	you	need	to	do	is	select	the	object	you	want	to	color	and	choose	a	color	from	the	palette.	If	you	already	have	a	color	in	mind,	you	can	also	type	in	the	number	in	the	search	bar.	The	Pantone	colors	that	you	clicked	on
previously	will	show	in	the	Swatches	panel.	You	can	save	the	colors	for	future	reference	if	you	need	them.	What	if	you	want	to	find	the	Pantone	color	of	a	CMYK	or	RGB	color?	Of	course,	you	can.	You	can	use	the	Recolor	Artwork	tool	to	convert	CMYK/RGB	colors	to	Pantone	Colors,	and	vice	versa.	Follow	the	steps	below	to	see	how	it	works!	Step	1:
Choose	the	colors	(objects)	you	want	to	convert.	For	example,	I	designed	this	vector	for	printing	on	a	T-shirt.	Its	in	RGB	color	mode,	but	I	want	to	find	out	the	corresponding	Pantone	colors.	Step	2:	Go	to	the	overhead	menu	and	choose	Edit	>	Edit	Colors	>	Recolor	Artwork.	You	should	see	a	color	panel	like	this.	Step	3:	Click	Color	Library	>	Color
Books	and	choose	a	Pantone	option.	Then	the	panel	should	look	like	this.	You	can	save	the	Pantone	colors	to	the	Swatches	by	clicking	on	the	save	file	option	and	choosing	Save	All	Colors.	The	Pantone	colors	from	this	artwork	will	show	on	the	Swatches	panel.	Hover	over	the	color	and	youll	see	the	Pantone	Color	number	of	the	color.	There	you	go,	this
is	how	you	find	out	the	Pantone	colors	equivalent	to	CMYK	or	RGB	colors.	There	isnt	a	Pantone	color	mode	in	Adobe	Illustrator,	but	you	can	certainly	use	Pantone	colors	on	artwork	or	find	the	Pantone	color	of	your	design.	Keep	in	mind	that	when	you	save	or	export	a	file,	the	color	mode	wont	change	to	Pantone	but	you	can	definitely	note	down	the
Pantone	color	and	let	the	print	shop	know.	This	website	contains	affiliate	links.	As	an	Amazon	affiliate,	I	earn	from	qualifying	purchases,	our	own	services	and	products.	The	content	on	this	website	was	created	with	the	help	of	AI.Okay,	real	talk:	when	Adobe	yanked	the	Pantone	Color	Books	from	Illustrator	(starting	with	version	28.0),	I	felt	like
someone	had	just	deleted	my	favorite	fonts	folder.	You	open	up	Illustrator,	head	over	to	Swatch	Libraries	>	Color	Books,	and	nothing.	Just	a	big	ol	void	where	your	Pantone+	Solid	Coated	used	to	live.If	youre	here	wondering:How	do	I	get	Pantone	colors	back	in	Illustrator	2024?	Where	did	the	Pantone	swatches	go?	Is	there	still	a	way	to	find	Pantone
in	Adobe	Illustrator	without	paying	extra?youre	not	alone.	And	yes,	there	is	a	way.This	post	walks	you	through	everything	step-by-stepfrom	installing	the	Pantone	Connect	plugin	(spoiler:	its	limited	unless	you	pay)	to	a	little-known	workaround	where	you	copy	Pantone	color	books	from	older	Illustrator	versions	into	your	latest	one.	Yep.	Manual.	But	it
works.Ive	also	covered	how	to:Install	Pantone	swatches	manually	in	Illustrator	Find	Pantone	libraries	when	Pantone	Connect	isnt	working	And	how	to	make	Illustrator	behave	like	the	good	old	days	(almost)Once	youve	got	the	Pantone	colors	back	in	your	Illustrator,	youll	probably	want	to	convert	your	CMYK	colors	to	Pantone	for	print	jobs.	I	made	a
super	quick	guide	on	that	too:	How	To	Convert	CMYK	To	Pantone	In	IllustratorSo,	if	youve	been	Googling	around	for	how	to	find	Pantone	color	in	Illustrator	2024	without	plugin	or	youre	just	frustrated	with	the	missing	swatchestake	a	breath.	Youve	got	options.	And	Ill	walk	you	through	it.By	default,	any	Illustrator	file	will	either	be	in	the	RGB	or
CMYK	color	mode.	Any	CMYK	or	RGB	color	depends	on	your	monitor	or	printer	depending	on	your	RGB	and	CMYK	values.	But	there	isnt	any	Pantone	colour	mode.	Pantone	came	up	with	the	Pantone	Matching	System	(PMS)	to	standardize	and	maintain	color	consistency	or	match	colors	when	a	design	enters	the	preview	and	production	stage,
regardless	of	the	equipment	used	to	produce	the	color.Pantone	is	not	part	of	Adobe	and	its	a	separate	entity	altogether.Even	without	all	the	Pantone	Color	Books	available	in	Illustrator,	you	can	still	find	Pantone	Colors	in	Illustrator.	To	do	that,	you	will	need	to	install	a	plugin	called	Pantone	Connect	via	Adobe	Creative	Cloud.Pantone	Connect	is	free
only	for	limited	functions:Search	Pick	any	15,000	Colors	See	Pantone	Color	Reference	Number	Measure	Up	to	10	Palettes	Unlimited	Share	If	you	need	anything	else	such	as	extracting	colors,	analyzing	colors,	and	converting	them,	you	will	have	to	pay	US$20.99	per	month	or	US$125.99	per	year.To	use	Pantone	Connect,	first,	you	will	have	to	quit	all
Adobe	programs.	Next,	your	desktop	has	to	be	logged	in	to	Creative	Cloud.	Click	on	the	Creative	Cloud	icon	on	the	top	menu	bar	if	you	are	on	a	Mac,	or	open	your	Creative	Cloud	platform	if	you	are	on	Windows.	Then,	select	Stock	&	Marketplace.Under	Search,	All	Plugins	on	the	left	sidebar,	type	in	Pantone	Connect	to	search	for	the	plugin.	Then,	click
the	button	that	says	Get	on	the	Pantone	Connect	box.	This	will	start	the	installation	process.Reopen	your	Adobe	Illustrator.	Select	Window	>	Extensions	and	you	will	see	Pantone	Connect	as	an	option.	Select	Pantone	Connect	and	the	Pantone	Connect	window	opens	up.	Sign	up	for	an	account	and	you	are	ready	to	use	it.Pantone	color	books	have	been
removed	from	Adobe	Illustrator	between	2022	and	2023.	I	know,	you	used	to	be	able	to	find	them	via	Window	>	Swatch	Libraries	>	Other	Library	But	now	they	have	disappeared.	If	you	are	using	Adobe	Illustrator	v28.0,	you	will	not	be	able	to	find	any	Pantone	color	books.Before	you	can	do	that,	you	will	have	to	install	Pantone	color	files	to	your	latest
Illustrator	version.	Without	those	files,	you	wont	be	able	to	find	the	colors	within	your	Illustrator	app.Note:	Im	using	MacBook	Pro	macOS	Ventura	Version	13.5	with	Adobe	Illustrator	2023	Version	28.0.Here	are	the	steps:The	first	step	is	to	launch	Adobe	Creative	Cloud	app	on	your	computer.Navigate	to	the	All	Apps	section.Go	to	the	Installed	section
and	you	will	most	likely	find	only	one	Illustrator	version.	Go	to	the	right-hand	side	of	the	column	and	select	the	three	dots.Select	the	Other	Versions	option	in	the	drop-down	menu.	A	pop-up	will	show	all	the	current	and	past	versions	available	for	download.Go	to	the	earlier	version	and	select	the	Install	button	on	the	right-hand	side.Wait	for	a	few
minutes	for	the	installation	to	complete.In	this	example,	Ive	installed	Illustrator	v27.0,	one	of	the	earlier	Adobe	Illustrator	2023	versions.Go	to	your	Applications	folder	in	Mac	or	Downloads	folder	in	Windows.Select	the	Illustrator	version	folder	youve	just	installed.	Select	the	Presets	folder.	Then,	select	the	language	folder	and	then,	select	the
Swatches	folder.	Next,	select	the	Color	Books	folder.	In	my	example,	I	have	selected	Adobe	Illustrator	2022	>	Presets	>	en_US	>	Swatches	>	Color	Books.You	will	see	at	least	5	Pantone	files:PANTONE+	CMYK	Coated	PANTONE+	CMYK	Uncoated	PANTONE+	Metallic	Coated	PANTONE+	Solid	Coated	PANTONE+	Solid	UncoatedSelect	these	5	files
and	copy	them	by	doing	a	right-click	with	your	cursor,	and	selecting	Copy	in	the	drop-down	menu.With	the	Pantone	color	files	in	your	clipboard,	go	to	the	Applications	or	Downloads	folder,	and	select	the	latest	Adobe	Illustrator	folder.	In	my	example,	that	would	be	the	Adobe	Illustrator	2024	folder.Then	similarly	to	Step	2,	go	to	Adobe	Illustrator	2024
>	Presets	>	en_US	>	Swatches	>	Color	Books.	Paste	the	Pantone	files	youve	just	copied	into	this	folder.Quit	Illustrator	and	reopen	it.	In	the	next	section,	you	will	learn	various	methods	on	how	to	find	the	Pantone	Color	you	want	in	Illustrator.The	best	way	to	find	the	Pantone	Color	of	your	object	in	Adobe	Illustrator	is	to	first	open	your	object	in
Illustrator.	Then,	click	on	one	area	of	your	object	to	select	it.	Next,	go	to	the	top	menu	and	select	Window	>	Swatches.	In	the	Color	Swatches,	you	will	see	a	color	square	bar	selected.	Bring	your	cursor	over	it	and	you	will	see	the	Pantone	color	code	of	your	object	area,	for	example	Pantone	P	Process	Black	C.Here	are	the	various	methods	to	find
Pantone	color,	or	you	can	also	convert	CMYK	to	Pantone	in	Illustrator:At	the	Top	Menu,	select	Window,	scroll	down	to	select	Swatch	Libraries,	then	select	Color	Books,	and	select	any	of	the	Pantone	color	guides:Window	>	Swatch	Libraries	>	Color	Books	>	Pantone	Color	BooksNote:	This	will	work	whether	or	not	your	artboard	is	visible	or
hidden.Open	the	Swatches	Panel	by	going	to	the	Top	Menu,	and	select	Window	>	Swatches.	This	opens	up	the	Swatches	Panel.Then,	on	the	Swatches	Panel,	you	will	see	an	icon	with	3	lines	in	the	top	right-hand	corner.	That	is	the	Swatches	options	menu.	Select	that	and	a	dropdown	menu	appears.	Select	open	swatch	library	>	color	books.	This	is
where	Illustrator	stores	different	color	libraries	including	the	Pantone	color	libraries.	Select	any	of	the	Pantone	Color	Books	based	on	the	Pantone	color	system.First,	open	the	Swatches	Panel	by	selecting	Window	>	Swatches	from	the	Top	Menu.	Then,	select	the	Swatch	Libraries	menu	in	the	bottom	left	corner	of	the	panel.	This	opens	up	a	dropdown
menu	where	you	can	select	Color	Books,	which	opens	up	another	dropdown	menu.	Select	your	desired	Pantone	Color	Book.This	could	be	one	of	the	best	ways	to	find	Pantone	Color	in	Illustrator.	Simply	select	Help	on	the	Top	Menu.	Enter	Pantone	in	the	search	bar.	Then	select	any	of	the	options	and	the	dropdown	menu	opens	up	to	show	you	where
you	can	find	the	item	in	the	menu.	Pantone	Connect	is	free	for	basic	features	like	color	search,	picking	colors,	and	viewing	color	codes.	But	if	you	want	to	extract	colors	from	artwork,	convert	CMYK/RGB	to	Pantone,	or	access	full	features,	youll	need	a	paid	subscription	(US$20.99/month	or	US$125.99/year).To	stay	on	the	free	plan,	you	can	create	up
to	10	palettes	and	use	limited	features.	First,	make	sure:	Youve	installed	the	plugin	viaCreative	Cloud	>	Stock	&	Marketplace.	Youvequit	and	reopened	Illustrator.	Go	toWindow	>	Extensions	>	Pantone	Connect.If	you	still	dont	see	it:	Reinstall	the	plugin	Check	that	youre	using	asupported	version	(v27	or	later)	Make	sure	youre	logged	into	Creative
Cloud	Although	most	of	the	projects	use	either	CMYK	or	RGB	mode,	they	are	not	always	enough.	What	if	you	want	to	use	Pantone	colors	for	products?	If	you	use	Adobe	Illustrator	for	fashion	design,	its	a	good	idea	to	have	the	Pantone	palettes	handy.	Normally	we	use	CMYK	color	mode	for	print.	Well,	more	specifically	printing	on	paper,	because
printing	on	other	materials	is	another	story.	Technically,	you	can	use	CMYK	or	RGB	to	print	on	products,	but	having	the	Pantone	colors	is	a	better	option.	In	this	article,	youll	learn	how	to	find	and	use	Pantone	colors	in	Adobe	Illustrator.	Note:	all	screenshots	are	taken	from	Adobe	Illustrator	CC	Mac	version.	Windows	or	other	versions	can	look
different.Since	August	2022,	Pantone	Color	Books	are	not	available	in	Illustrator	anymore.	So	if	you	want	to	find	the	Pantone	color	swatch,	you	do	need	to	get	the	older	version	of	Illustrator.	You	wont	be	able	to	choose	Pantone	as	a	color	mode,	but	you	can	find	it	in	the	Swatches	panel	or	when	you	recolor	artwork.	If	you	havent	opened	the	Swatches
panel	already,	go	to	Window	>	Swatches.	Click	on	the	hidden	menu	and	choose	Open	Swatch	Library	>	Color	Books	and	then	choose	one	of	the	Pantone	options.	Usually,	I	choose	Pantone+	CMYK	Coated	or	Pantone+	CMYK	Uncoated	depending	on	the	project.	Once	you	chose	an	option,	a	Pantone	panel	will	appear.	Now	you	can	apply	Pantone	colors
to	your	artwork.	If	youre	using	any	Illustrator	version	later	than	the	2023	update,	you	wont	see	the	Pantone	swatches	in	the	Color	Books	anymore.	In	this	case,	you	need	to	uninstall	your	current	Illustrator	version	from	Adobe	Creative	Cloud	and	download	the	older	version	of	Adobe	Illustrator.	From	there,	you	can	copy	the	Pantone	swatches	and	paste
them	into	your	current	version	folder.	Here	are	some	recommendations	from	Adobe,	including	the	detailed	steps	to	make	the	swatches	transfer:	Learn	about	the	Pantone	Plus	libraries	in	Illustrator.	Once	you	got	that	fixed,	you	can	follow	the	steps	below	to	use	Pantone	Colors	in	Illustrator.	Using	the	Pantone	colors	is	the	same	as	using	color	swatches.
All	you	need	to	do	is	select	the	object	you	want	to	color	and	choose	a	color	from	the	palette.	If	you	already	have	a	color	in	mind,	you	can	also	type	in	the	number	in	the	search	bar.	The	Pantone	colors	that	you	clicked	on	previously	will	show	in	the	Swatches	panel.	You	can	save	the	colors	for	future	reference	if	you	need	them.	What	if	you	want	to	find
the	Pantone	color	of	a	CMYK	or	RGB	color?	Of	course,	you	can.	You	can	use	the	Recolor	Artwork	tool	to	convert	CMYK/RGB	colors	to	Pantone	Colors,	and	vice	versa.	Follow	the	steps	below	to	see	how	it	works!	Step	1:	Choose	the	colors	(objects)	you	want	to	convert.	For	example,	I	designed	this	vector	for	printing	on	a	T-shirt.	Its	in	RGB	color	mode,
but	I	want	to	find	out	the	corresponding	Pantone	colors.	Step	2:	Go	to	the	overhead	menu	and	choose	Edit	>	Edit	Colors	>	Recolor	Artwork.	You	should	see	a	color	panel	like	this.	Step	3:	Click	Color	Library	>	Color	Books	and	choose	a	Pantone	option.	Then	the	panel	should	look	like	this.	You	can	save	the	Pantone	colors	to	the	Swatches	by	clicking	on
the	save	file	option	and	choosing	Save	All	Colors.	The	Pantone	colors	from	this	artwork	will	show	on	the	Swatches	panel.	Hover	over	the	color	and	youll	see	the	Pantone	Color	number	of	the	color.	There	you	go,	this	is	how	you	find	out	the	Pantone	colors	equivalent	to	CMYK	or	RGB	colors.	There	isnt	a	Pantone	color	mode	in	Adobe	Illustrator,	but	you
can	certainly	use	Pantone	colors	on	artwork	or	find	the	Pantone	color	of	your	design.	Keep	in	mind	that	when	you	save	or	export	a	file,	the	color	mode	wont	change	to	Pantone	but	you	can	definitely	note	down	the	Pantone	color	and	let	the	print	shop	know.	As	designers,	were	always	on	the	lookout	for	ways	to	ensure	our	designs	are	accurate,
consistent,	and	professional.	One	crucial	aspect	of	achieving	this	is	by	using	precise	colors	that	match	our	brands	identity	or	clients	requirements.	In	the	world	of	design,	Pantone	colors	are	the	gold	standard	for	color	accuracy	and	consistency.	However,	loading	Pantone	colors	in	Adobe	Illustrator	can	be	a	daunting	task,	especially	for	beginners.	In
this	comprehensive	guide,	well	take	you	through	the	step-by-step	process	of	loading	Pantone	colors	in	Illustrator	2025,	ensuring	your	designs	are	always	on	point.Understanding	Pantone	Colors	Pantone	colors	are	a	standardized	color	matching	system	used	globally	in	various	industries,	including	design,	printing,	and	textiles.	The	Pantone	color	system
consists	of	over	1,000	unique	colors,	each	with	its	own	unique	formula	and	reference	number.	These	colors	are	created	using	a	specific	mixture	of	14	base	pigments,	ensuring	consistency	and	accuracy	across	different	materials	and	printing	processes.In	the	design	world,	Pantone	colors	are	essential	for	maintaining	brand	identity	and	consistency
across	various	marketing	materials,	packaging,	and	products.	By	using	Pantone	colors,	designers	can	ensure	that	their	designs	are	accurately	reproduced,	regardless	of	the	printing	process	or	material	used.Why	Use	Pantone	Colors	in	Illustrator?There	are	several	reasons	why	using	Pantone	colors	in	Illustrator	is	crucial	for	designers:Color	accuracy:
Pantone	colors	ensure	that	your	designs	are	accurately	reproduced,	maintaining	the	desired	color	tone	and	hue.Consistency:	By	using	Pantone	colors,	you	can	ensure	consistency	across	different	design	elements,	materials,	and	printing	processes.Brand	identity:	Pantone	colors	help	maintain	brand	identity	and	recognition,	ensuring	that	your	designs
align	with	the	brands	visual	identity.Professionalism:	Using	Pantone	colors	demonstrates	a	level	of	professionalism	and	attention	to	detail,	setting	your	designs	apart	from	others.Loading	Pantone	Colors	in	Illustrator	2025Now	that	weve	established	the	importance	of	using	Pantone	colors,	lets	dive	into	the	step-by-step	process	of	loading	them	in
Illustrator	2025.	Method	1:	Loading	Pantone	Colors	from	the	Swatches	PanelThe	first	method	involves	loading	Pantone	colors	directly	from	the	Swatches	panel	in	Illustrator.Step	1:	Open	the	Swatches	panel	by	going	to	Window	>	Swatches	or	by	using	the	keyboard	shortcut	Ctrl	+	F5	(Windows)	or	Command	+	F5	(Mac).Step	2:	Click	on	the	New
Swatch	button	at	the	bottom	of	the	Swatches	panel.	Step	3:	In	the	New	Swatch	dialog	box,	select	Pantone	from	the	Color	Mode	dropdown	menu.	(See	Also:	Did	the	Chargers	Change	Their	Colors?	The	Shocking	Truth)Step	4:	Enter	the	Pantone	color	reference	number	or	select	it	from	the	Pantone	Color	Finder	tool.Step	5:	Click	OK	to	add	the	Pantone
color	to	your	Swatches	panel.Method	2:	Loading	Pantone	Colors	from	a	Color	LibraryThe	second	method	involves	loading	Pantone	colors	from	a	color	library	file	(.ase	or	.acb).Step	1:	Create	a	new	document	or	open	an	existing	one	in	Illustrator.Step	2:	Go	to	File	>	Open	and	select	the	Pantone	color	library	file	(.ase	or	.acb)	you	want	to	load.Step	3:	In
the	Open	dialog	box,	select	the	Color	Library	option	and	click	Open.Step	4:	The	Pantone	colors	from	the	selected	library	file	will	be	loaded	into	your	Swatches	panel.Method	3:	Loading	Pantone	Colors	from	a	Pantone	Color	BridgeThe	third	method	involves	loading	Pantone	colors	from	a	Pantone	Color	Bridge	file	(.acb).Step	1:	Create	a	new	document
or	open	an	existing	one	in	Illustrator.Step	2:	Go	to	File	>	Open	and	select	the	Pantone	Color	Bridge	file	(.acb)	you	want	to	load.Step	3:	In	the	Open	dialog	box,	select	the	Pantone	Color	Bridge	option	and	click	Open.Step	4:	The	Pantone	colors	from	the	selected	Color	Bridge	file	will	be	loaded	into	your	Swatches	panel.	(See	Also:	What	Do	the	American
Flag	Colors	Represent?	A	Symbolic	Guide)Working	with	Pantone	Colors	in	IllustratorNow	that	youve	loaded	Pantone	colors	in	Illustrator,	lets	explore	how	to	work	with	them	effectively.Converting	Pantone	Colors	to	CMYKWhen	working	with	Pantone	colors,	its	essential	to	understand	that	they	are	spot	colors,	meaning	they	are	not	part	of	the	CMYK
color	model.	To	convert	Pantone	colors	to	CMYK,	follow	these	steps:Step	1:	Select	the	Pantone	color	you	want	to	convert	in	the	Swatches	panel.Step	2:	Go	to	Edit	>	Convert	to	CMYK.Step	3:	In	the	Convert	to	CMYK	dialog	box,	select	the	desired	CMYK	color	profile	and	click	OK.The	Pantone	color	will	be	converted	to	its	closest	CMYK	equivalent,
ensuring	accurate	color	reproduction.Using	Pantone	Colors	in	Your	DesignOnce	youve	loaded	and	converted	Pantone	colors,	you	can	use	them	in	your	design	just	like	any	other	color.Step	1:	Select	the	object	or	text	you	want	to	apply	the	Pantone	color	to.Step	2:	Go	to	the	Swatches	panel	and	select	the	Pantone	color	you	want	to	apply.Step	3:	Click	on
the	Apply	button	to	apply	the	Pantone	color	to	your	selection.Tips	and	TricksHere	are	some	additional	tips	and	tricks	to	keep	in	mind	when	working	with	Pantone	colors	in	Illustrator:Always	use	the	latest	Pantone	color	libraries	to	ensure	accuracy	and	consistency.	(See	Also:	What	Colors	Look	Good	on	Light	Olive	Skin?	Flattering	Shades	Revealed)Use
the	Pantone	Color	Finder	tool	to	quickly	find	and	load	Pantone	colors.Convert	Pantone	colors	to	CMYK	before	sending	your	design	to	print	to	ensure	accurate	color	reproduction.Use	Pantone	colors	in	conjunction	with	other	design	elements,	such	as	typography	and	imagery,	to	create	visually	appealing	designs.Recap	and	SummaryIn	this
comprehensive	guide,	weve	covered	the	importance	of	using	Pantone	colors	in	Illustrator,	as	well	as	the	step-by-step	process	of	loading	them	using	three	different	methods.	Weve	also	explored	how	to	work	with	Pantone	colors,	including	converting	them	to	CMYK	and	using	them	in	your	design.	By	following	these	tips	and	tricks,	youll	be	able	to	ensure
color	accuracy	and	consistency	in	your	designs,	setting	you	apart	from	others	in	the	design	industry.Frequently	Asked	QuestionsQ:	What	is	the	difference	between	Pantone	colors	and	CMYK	colors?Pantone	colors	are	spot	colors,	meaning	they	are	not	part	of	the	CMYK	color	model.	CMYK	colors,	on	the	other	hand,	are	process	colors	created	by
combining	cyan,	magenta,	yellow,	and	black	inks.	Pantone	colors	are	used	for	accurate	color	reproduction,	while	CMYK	colors	are	used	for	printing.Q:	How	do	I	know	which	Pantone	color	to	use	for	my	design?Choose	a	Pantone	color	that	matches	your	brands	identity	or	clients	requirements.	You	can	also	use	the	Pantone	Color	Finder	tool	to	find	the
closest	match	to	your	desired	color.Q:	Can	I	use	Pantone	colors	in	other	Adobe	Creative	Cloud	applications?Yes,	Pantone	colors	can	be	used	in	other	Adobe	Creative	Cloud	applications,	including	Photoshop,	InDesign,	and	Premiere	Pro.	However,	the	process	of	loading	Pantone	colors	may	vary	depending	on	the	application.Q:	Are	Pantone	colors
compatible	with	all	printing	processes?Pantone	colors	are	compatible	with	most	printing	processes,	including	offset	printing,	digital	printing,	and	screen	printing.	However,	its	essential	to	check	with	your	printer	to	ensure	compatibility	and	accurate	color	reproduction.Q:	How	often	are	new	Pantone	colors	released?New	Pantone	colors	are	released
annually,	with	the	Pantone	Color	Institute	announcing	the	Pantone	Color	of	the	Year	in	December.	Additionally,	Pantone	releases	new	color	libraries	and	updates	existing	ones	regularly	to	ensure	designers	have	access	to	the	latest	colors	and	trends.	Although	most	of	the	projects	use	either	CMYK	or	RGB	mode,	they	are	not	always	enough.	What	if	you
want	to	use	Pantone	colors	for	products?	If	you	use	Adobe	Illustrator	for	fashion	design,	its	a	good	idea	to	have	the	Pantone	palettes	handy.	Normally	we	use	CMYK	color	mode	for	print.	Well,	more	specifically	printing	on	paper,	because	printing	on	other	materials	is	another	story.	Technically,	you	can	use	CMYK	or	RGB	to	print	on	products,	but
having	the	Pantone	colors	is	a	better	option.	In	this	article,	youll	learn	how	to	find	and	use	Pantone	colors	in	Adobe	Illustrator.	Note:	all	screenshots	are	taken	from	Adobe	Illustrator	CC	Mac	version.	Windows	or	other	versions	can	look	different.Since	August	2022,	Pantone	Color	Books	are	not	available	in	Illustrator	anymore.	So	if	you	want	to	find	the
Pantone	color	swatch,	you	do	need	to	get	the	older	version	of	Illustrator.	You	wont	be	able	to	choose	Pantone	as	a	color	mode,	but	you	can	find	it	in	the	Swatches	panel	or	when	you	recolor	artwork.	If	you	havent	opened	the	Swatches	panel	already,	go	to	Window	>	Swatches.	Click	on	the	hidden	menu	and	choose	Open	Swatch	Library	>	Color	Books
and	then	choose	one	of	the	Pantone	options.	Usually,	I	choose	Pantone+	CMYK	Coated	or	Pantone+	CMYK	Uncoated	depending	on	the	project.	Once	you	chose	an	option,	a	Pantone	panel	will	appear.	Now	you	can	apply	Pantone	colors	to	your	artwork.	If	youre	using	any	Illustrator	version	later	than	the	2023	update,	you	wont	see	the	Pantone
swatches	in	the	Color	Books	anymore.	In	this	case,	you	need	to	uninstall	your	current	Illustrator	version	from	Adobe	Creative	Cloud	and	download	the	older	version	of	Adobe	Illustrator.	From	there,	you	can	copy	the	Pantone	swatches	and	paste	them	into	your	current	version	folder.	Here	are	some	recommendations	from	Adobe,	including	the	detailed
steps	to	make	the	swatches	transfer:	Learn	about	the	Pantone	Plus	libraries	in	Illustrator.	Once	you	got	that	fixed,	you	can	follow	the	steps	below	to	use	Pantone	Colors	in	Illustrator.	Using	the	Pantone	colors	is	the	same	as	using	color	swatches.	All	you	need	to	do	is	select	the	object	you	want	to	color	and	choose	a	color	from	the	palette.	If	you	already
have	a	color	in	mind,	you	can	also	type	in	the	number	in	the	search	bar.	The	Pantone	colors	that	you	clicked	on	previously	will	show	in	the	Swatches	panel.	You	can	save	the	colors	for	future	reference	if	you	need	them.	What	if	you	want	to	find	the	Pantone	color	of	a	CMYK	or	RGB	color?	Of	course,	you	can.	You	can	use	the	Recolor	Artwork	tool	to
convert	CMYK/RGB	colors	to	Pantone	Colors,	and	vice	versa.	Follow	the	steps	below	to	see	how	it	works!	Step	1:	Choose	the	colors	(objects)	you	want	to	convert.	For	example,	I	designed	this	vector	for	printing	on	a	T-shirt.	Its	in	RGB	color	mode,	but	I	want	to	find	out	the	corresponding	Pantone	colors.	Step	2:	Go	to	the	overhead	menu	and	choose	Edit
>	Edit	Colors	>	Recolor	Artwork.	You	should	see	a	color	panel	like	this.	Step	3:	Click	Color	Library	>	Color	Books	and	choose	a	Pantone	option.	Then	the	panel	should	look	like	this.	You	can	save	the	Pantone	colors	to	the	Swatches	by	clicking	on	the	save	file	option	and	choosing	Save	All	Colors.	The	Pantone	colors	from	this	artwork	will	show	on	the
Swatches	panel.	Hover	over	the	color	and	youll	see	the	Pantone	Color	number	of	the	color.	There	you	go,	this	is	how	you	find	out	the	Pantone	colors	equivalent	to	CMYK	or	RGB	colors.	There	isnt	a	Pantone	color	mode	in	Adobe	Illustrator,	but	you	can	certainly	use	Pantone	colors	on	artwork	or	find	the	Pantone	color	of	your	design.	Keep	in	mind	that
when	you	save	or	export	a	file,	the	color	mode	wont	change	to	Pantone	but	you	can	definitely	note	down	the	Pantone	color	and	let	the	print	shop	know.	In	November	of	2022,	Adobe	and	Pantone	parted	ways.	The	ultimate	color	couple	split	because	Pantone	got	greedy	and	demanded	Adobe	pay	up	for	raiding	their	swatch	stash	for	so	many	years.	Adobe
snapped,	packing	Pantones	libraries	in	a	sad	cardboard	box	and	tossing	them	to	the	curb.	Now,	were	left	to	pick	up	the	pieces.Im	sure	you	reminisce	about	the	good	old	days	when	you	could	head	over	to	the	swatch	panel,	click	the	trust	hamburger	menu,	and	open	up	the	Pantone	Solid	Coated	library.	You	probably	even	knew	the	trick	with	the	recolor
artwork	panel	that	allowed	you	to	convert	CMYK	to	Pantone	in	a	flash.	None	of	that	works	anymore,	and	our	jobs	depend	on	it,	so	what	are	we	logo	designers	to	do?	If	youre	loaded	and	have	a	weird	fetish	for	monthly	subscriptions,	you	could	always	use	Pantones	extension	for	Illustrator,	Pantone	Connect.	My	sense	of	justice	wont	let	me	pony	up	for
the	service.	Instead,	I	say	we	reclaim	what	was	stolen	from	us	and	get	our	Pantone	swatches	back!Since	Pantone	and	Adobe	broke	up,	its	become	so	much	more	difficult	to	get	Pantone	information	for	colors.	Swatch	automatically	converts	your	colors	to	the	best	Pantone	match.	Pantone	is	BACK	in	Illustrator,	without	monthly	fees!Here	are	the	three
best	ways	to	do	that:Copy	Color	BooksAdobe	used	to	provide	the	Pantone	color	libraries	in	their	older	versions	and	they	still	do!	All	you	have	to	do	is	install	Adobe	Illustrator	V27.0	or	older,	and	you	can	still	use	the	color	books.	Ill	show	you	how	to	install	an	older	version	in	just	a	second,	but	I	can	already	hear	you	saying,	But	then	I	dont	get	all	the
exciting	features	from	new	releases!	Alright,	I	hear	you,	but	the	beautiful	thing	about	installing	the	old	versions	is	that	it	gives	you	the	actual	Pantone	color	library	files.	If	you	move	those	files	to	the	correct	location	in	new	versions,	you	will	still	have	access	to	Pantone	libraries	in	your	fancy	new	versions	of	Illustrator!Ok,	so	heres	how	to	install	an	old
version:1.	Open	the	Adobe	Creative	Cloud	App2.	Click	the	Apps	tab	at	the	top	of	the	window3.	Find	Illustrator	in	your	list	of	apps	and	then	click	the	3	dots	icon	on	the	right.4.	Click	Other	Versions5.	Choose	V27.0	or	olderNow,	you	can	either	continue	to	use	the	old	Illustrator	version	for	your	Pantone	color	needs,	or	you	can	steal	the	libraries	from	the
old	version	and	add	them	to	the	new	version!Heres	how	to	add	Pantone	libraries	to	newer	versions	of	Illustrator1.	Go	to	your	applications	folder	and	find	the	old	version	of	Illustrator.	It	will	be	Adobe	Illustrator	2022	or	older.2.	Go	to	the	Illustrator	application	folder	>	Presets	>	en_US	(this	colder	could	be	different	depending	on	your	language
settings)	>	Swatches	>	Color	Books.3.	Copy	PANTONE+	Solid	Coated.acb	and	PANTONE+	Solid	Uncoated.acb4.	Go	to	the	newer	version	of	Illustrator	in	your	applications	folder	and	paste	the	color	libraries	into	the	same	folder	as	the	old	version.5.	Open	up	the	swatch	panel	in	Illustrator	and	go	to	Open	Swatch	Library	>	Color	Books	>	PANTONE+
Solid	Coated	or	PANTONE+	Solid	Uncoated.I	recommend	keeping	a	copy	of	these	Pantone	color	libraries	in	an	easy-to-access	location	so	that	you	dont	have	to	go	digging	every	time	you	update	Illustrator.Note:	The	default	color	libraries	included	in	older	versions	of	Illustrator	do	not	include	all	the	newest	Pantone	colors.	Using	these	libraries	will
limit	your	options	to	an	older,	smaller	set	of	Pantone	colors.BenefitsThe	benefits	of	using	this	first	method	for	getting	Pantone	colors	into	newer	versions	of	Illustrator	are	basically	just	putting	things	back	to	how	they	were.	Youll	access	colors	through	the	swatch	panel	like	youre	used	to.	Since	the	color	books	are	restored,	you	can	even	use	the	recolor
panel	to	automatically	convert	RGB	or	CMYK	to	Pantone.A	Sneaky	ResourceYou	didnt	hear	it	from	me,	but	some	people	have	shared	the	newer	color	libraries	online.	You	can	find	them	here:	the	same	steps	from	earlier,	and	youll	have	a	much	newer	set	of	Pantone	swatches	to	choose	from	than	the	old	Illustrator	defaults.Make	ASE	FilesThis
workaround	also	requires	that	you	download	an	older	version	of	Illustrator,	so	go	ahead	and	do	that	following	the	steps	above.	This	method	is	going	to	make	use	of	.ase	files.	ASE	means	Adobe	Swatch	Exchange,	and	its	a	format	that	can	be	read	by	all	the	Adobe	programs.	Typically,	a	designer	will	want	to	save	a	library	of	the	brand	colors	for	a
specific	client	or	project.	They	will	save	their	current	swatches	as	an	ASE	file	to	be	loaded	into	any	project	for	that	brand.	Its	pretty	handy.	We	will	hack	the	ASE	a	little	to	make	our	own	Pantone	library.Follow	these	steps	1.	Open	a	blank	document	in	an	old	version	of	Illustrator	that	still	has	the	Pantone	color	libraries.2.	Go	to	the	swatches	panel	and
click	the	menu.	Choose	Select	all	Unused	Colors	and	then	click	the	trash	can	to	delete	all	of	the	swatches	in	the	blank	document.	If	any	remain,	highlight	them	and	click	the	trash	icon	(you	cannot	delete	the	no-fill	swatch	or	the	registration	swatch).3.	Open	up	the	swatch	panel	in	Illustrator,	click	the	menu	icon	in	the	upper	right	corner	of	the	window,
and	go	to	Open	Swatch	Library	>	Color	Books	>	PANTONE+	Solid	Coated	or	PANTONE+	Solid	Uncoated.4.	Shift-click	to	select	every	Pantone	swatch	in	the	library	and	drag	them	into	the	Swatches	panel.5.	Click	the	Swatch	panel	menu	and	choose	Save	Swatch	Library	as	ASE6.	You	can	name	the	library	whatever	you	want,	but	I	recommend	calling	it
something	like	Pantone	Coated.Now	that	the	ASE	is	saved,	you	can	open	it	in	any	version	of	Illustrator	or	in	other	Adobe	tools	like	InDesign	or	Photoshop.	Simply	go	to	the	swatch	panel	menu	in	a	newer	version	of	Illustrator	and	click	Open	Swatch	Library	>	Other	Library.	Navigate	to	where	you	save	the	ASE	and	open	it.	As	I	noted	in	the	last	method,
you	should	definitely	save	these	ASE	files	to	a	memorable	and	easy-to-access	location.BenefitsThe	benefits	of	this	method	are	that	ASE	files	are	just	a	little	bit	easier	to	load	than	moving	color	library	files	from	one	obscure	system	folder	to	another.	They	can	also	be	opened	in	InDesign	and	Photoshop,	so	youre	increasing	your	access	to	the	Pantone
colors	across	the	whole	Adobe	suite	using	this	method.	Additionally,	you	can	customize	whats	in	an	ASE	file	to	only	include	specific	subsets	of	swatches	if	thats	what	youre	into.Open	Source	AlternativeAs	I	mentioned	in	the	intro	to	this	post,	designers	were	outraged	when	Adobe	and	Pantone	split.	Not	many	people	were	more	vocal	than	the	renowned
British	artist	Stuart	Semple	from	Culture	Hustle.	He	got	so	steamed	about	the	whole	thing	that	he	made	an	open-source	version	of	Pantone-ish	colors	and	gave	them	away	for	free	on	his	website.	Here	is	how	to	use	the	Freetone	colors	from	Culture	Hustle.You	may	be	wondering	how	you	can	use	a	Pantone	knockoff	in	actual	projects.	Well,	its	pretty
simple.	These	colors	are	just	clones	of	Pantone	libraries	with	the	Freetone	name	slapped	onto	the	beginning	the	numbers	are	the	same	as	Patnone.	If	you	use	one	of	these	swatches	in	a	project,	all	you	need	to	do	is	change	the	swatch	name	to	PANTONE	at	the	beginning	before	you	export,	and	your	printer	will	not	know	the	difference.	They	will	choose
the	correct	Pantone	ink	for	your	print	jobs.BenefitsHonestly,	I	think	Stuart	simply	made	an	ASE	and	changed	the	color	names.	If	you	like	sticking	it	to	the	man	and	want	to	show	solidarity	with	Stuart	and	Culture	Hustle,	you	can	grab	this	free,	open-source	alternative.	The	only	other	benefit	is	that	hes	included	spot	colors	for	his	unique	ink	products	in
there	as	well.Consolation	PrizeLastly,	suppose	you	dont	feel	that	any	of	this	is	ethical,	and	youre	worried	about	the	Pantone	legal	hammer	dropping	on	your	head.	In	that	case,	you	can	always	use	these	online	Pantone	converters	and	specify	the	Pantone	color	you	want	for	your	client	or	printer.	//www.easycalculation.com/colorconverter/hex-to-
pantone.php?	//www.ginifab.com/feeds/pms/cmyk_to_pantone.php	Anshul	Saini	Be	kind	and	respectful,	give	credit	to	the	original	source	of	content,	and	search	for	duplicates	before	posting.	Learn	more	To	find	a	specific	Pantone	Color	in	Illustrator:	Go	to	Window>Swatch	Libraries>	Color	Books.If	you	dont	find	your	color,	try	the	other	swatch	color
books	from	step	1.	How	To	Find	and	Add	Pantone	Colors	in	Photoshop	To	apply	a	Pantone	color	to	an	object	in	Illustrator:	Select	the	shape	using	the	selection	tool	(V)In	the	toolbar,	activate	the	Fill	or	Stroke	box	depending	on	where	you	want	to	apply	the	color.Select	the	desired	Pantone	color	from	the	swatches	panel	or	color	book.	Your	shape	should
now	have	the	fill	or	outline	in	that	color.	To	apply	a	Pantone	Color	as	a	gradient	in	Illustrator:	Select	the	shape	using	the	Selection	tool	(v).Open	up	the	gradient	panel	by	going	to	Window>Gradient.Drag	a	second	swatch	the	same	way.	Delete	unwanted	swatches	in	the	slider	by	selecting	them	and	using	the	trash	icon	(Delete	Stop)	on	the	right.You	can
save	your	gradient	to	your	swatches	by	clicking	the	drop-down	arrow	in	the	top	left	next	to	the	square	gradient	preview	and	clicking	the	add	to	swatches	icon.	To	convert	CMYK	swatches	to	Pantone	in	Adobe	Illustrator:	Select	the	shape	or	object	with	the	CMYK	fill	or	stroke	color	you	want	to	convert.Go	to	Window>Swatches	to	open	up	the	color
swatches	panel.Now	go	to	Edit>Edit	colors>	Recolor	ArtworkClick	the	Color	Reduction	Options	Icon.Select	Limit	to	Library.	In	the	drop-down,	choose	Color	books	and	the	Pantone	Library	you	want.Click	Ok,	and	Ok	again	in	the	Recolor	Artwork	window.Your	CMYK	color	is	now	converted	to	Pantone	and	the	swatch	should	appear	on	the	Swatches
Panel.	Converting	RGB	to	Pantone	is	similar	to	the	CMYK	to	Pantone	process	above.	To	convert	RGB	to	Pantone	color	in	Adobe	Illustrator:	Select	the	shape	or	object	with	the	RGB	fill	or	stroke	color	you	want	to	convert.Go	to	Window>Swatches	to	open	up	the	color	swatches	panel.Now	go	to	Edit>Edit	colors>	Recolor	ArtworkClick	the	Color
Reduction	Options	Icon.Select	Limit	to	Library.	In	the	drop-down,	choose	Color	books	and	the	Pantone	Library	you	want.Click	Ok,	and	Ok	again	in	the	Recolor	Artwork	window.Your	RGB	color	is	now	converted	to	Pantone	and	the	swatch	should	appear	on	the	Swatches	Panel.	Adobe	Illustrator	contains	10	Pantone	color	books	from	The	Pantone	Plus
Series.	You	can	find	them	by	going	to	Window>Swatch	Libraries>Color	Books.	If	the	Pantone	Color	Book	or	swatch	you	want	is	not	available	or	hasnt	been	updated	yet,	Heres	how	to	download	and	add	Pantone	Color	Books	to	Adobe	Illustrator:	Go	to	the	Adobe	Exchange	marketplace	and	install	Pantone	Connect.	You	may	need	to	Sign	In	to	your
Adobe	Account.After	its	done	installing,	restart	Adobe	Illustrator.Go	to	Window>	Extensions>	Pantone.The	Pantone	extension	allows	you	to	search	and	find	all	available	Pantone	Colors	and	automatically	keeps	the	Library	updated.	Note	that	Pantone	gives	you	an	intro	period	where	you	can	access	the	Pantone	connect	Library	for	free.	after	this	period
a	subscription	fee	may	apply,	find	more	details	at	the	bottom	of	the	Installation	page	in	the	Adobe	Exchange	Marketplace.	PMS	stands	for	Pantone	Matching	System.	It	is	a	standardized	color	identification	system	that	allocates	a	number	and	name	to	certain	unique	colors.	The	system	was	invented	by	chemist	Lawrence	Herbert	who	founded	Pantone
Inc.	PMS,	or	Pantone	color	guides,	are	used	by	printers,	manufacturers	and	designers	all	over	the	world.	Unlike	CMYK	which	uses	only	4	colors,	Pantone	uses	over	a	dozen	inks	that	can	be	mixed	in	different	ratios	to	create	over	10,000	standardized	colors.	The	colors	are	given	a	name	and	number,	for	example	Illuminating	whose	number	is	13-0647
TCX	can	be	identified	all	over	the	world	as	a	specific	type	of	yellow.	PMS	is	therefore	a	universal	color	language	that	helps	printers,	graphic	designers	and	illustrators	achieve	color	consistency	in	their	projects.	The	Pantone	Colors	of	the	Year	for	2021	Pantone,	through	the	Pantone	Color	Institute,	sets	the	years	color	trend	across	the	design	world	by
announcing	the	Color	of	the	Year.	2021s	color	of	the	Year	was	Ultimate	Gray	and	Illuminating.	Pantone	has	made	its	color	guides	available	both	through	Print	and	digitally	on	multiple	software.	The	Adobe	suite	of	programs	features	Pantone	Color	books	that	integrate	seamlessly	with	the	digital	tools	and	allow	designers	to	work	with	the	colors	right	on
screen.	See	the	guide	above	on	how	to	find	and	apply	Pantone	colors	in	Adobe	Illustrator.	You	may	also	like	to	learn:	How	to	clear	recent	files	in	illustrator	Any	questions	or	feedback	on	Pantone	colors	and	their	use	in	Adobe	programs?	Reach	me	via	the	contact	form	on	my	About	page.	Thanks	for	the	read!	Selecting	the	right	colors	for	your	design
projects	can	be	a	challenging	task.	Using	Pantone	colors	is	a	great	way	to	ensure	color	accuracy,	but	how	do	you	go	about	finding	the	specific	Pantone	color	match	in	Adobe	Illustrator?	In	this	comprehensive	guide,	well	walk	through	the	steps	and	tools	you	need	to	nail	the	perfect	Pantone	color	every	time	in	Illustrator.What	are	Pantone	Colors?Before
we	dive	into	how	to	find	Pantone	colors	in	Illustrator,	lets	quickly	cover	what	exactly	Pantone	colors	are.	Pantone	is	a	standardized	color	matching	system	used	primarily	in	the	design,	printing,	and	manufacturing	industries.	The	Pantone	Matching	System	includes	over	1,700	specific	colors	that	are	consistent	across	different	materials	and
mediums.Each	Pantone	color	has	a	specific	name	and	number	code.	For	example,	Pantone	123C	is	a	bright	yellow	and	Pantone	7565C	is	a	medium	blue.	No	matter	what	printer	or	fabric	a	design	is	produced	with,	the	Pantone	colors	will	be	consistent,	making	them	ideal	for	projects	that	need	precise	color	reproduction	across	different	vendors	and
materials.Using	Pantone	colors	ensures	colors	are	displayed	exactly	as	intended	across	different	applications,	devices,	and	physical	materials.	This	makes	them	a	go-to	choice	for	designers	and	companies	who	want	to	maintain	consistent	branding	and	color	schemes.Why	Use	Pantone	Colors	in	Illustrator?Adobe	Illustrator	is	a	vector	graphics	editor
commonly	used	for	design	work.	Here	are	some	of	the	key	benefits	of	using	Pantone	colors	in	Illustrator:Consistent	and	accurate	color	reproduction	Pantone	colors	eliminate	guesswork	and	manual	color	matching.Facilitates	collaboration	Entire	teams	can	work	from	the	same	precise	color	reference	points.Supports	branding	and	style	guides	Makes	it
easy	to	adhere	to	official	brand	color	specifications.Simplifies	approval	processes	No	back	and	forth	over	color	discrepancies.Enables	color	separation	for	printing	Pantone	colors	can	be	directly	translated	into	ink	mixing	formulas.Allows	color	consistency	across	different	materials	From	digital	design	to	plastic	products,	color	will	be	accurate.By	using
Pantone	colors	in	your	Illustrator	workflow,	you	can	streamline	projects	and	deliverables	with	precise,	consistent	color	every	time.How	to	Find	Pantone	Colors	in	IllustratorIllustrator	provides	a	few	different	options	for	selecting,	sampling,	and	converting	to	Pantone	colors.	Here	are	the	main	methods:1.	Use	the	Pantone	Color	BooksThe	traditional	way
of	selecting	Pantone	colors	is	via	physical	Pantone	color	books	or	swatch	cards.	These	display	all	the	colors	in	the	Pantone	Matching	System	in	fan	decks	or	binders.	To	select	a	color,	browse	the	books	and	identify	the	desired	color	visually.	The	colors	unique	Pantone	number	will	be	printed	next	to	each	swatch.You	can	then	manually	enter	this	number
into	Illustrators	color	picker	window	to	apply	that	specific	Pantone	color	to	objects	in	your	document.	The	downside	to	this	method	is	you	need	access	to	the	physical	color	books.	However,	it	allows	direct	and	tactile	selection	of	colors.2.	Use	the	Built-In	Pantone	LibraryA	more	convenient	option	is	to	access	Pantone	colors	directly	within	Illustrator.
Illustrator	comes	equipped	with	the	Pantone	Solid	Coated	color	library	containing	all	1,907	solid	Pantone	colors.To	access	this	library,	select	the	Color	panel	and	change	the	color	library	drop-down	to	Pantone	Solid	Coated.	You	can	then	browse	and	sample	any	Pantone	color	digitally.	This	eliminates	the	need	for	physical	swatch	books.3.	Use	the
Pantone	Color	FinderIllustrator	also	includes	a	tool	called	the	Pantone	Color	Finder.	This	allows	you	to	sample	colors	directly	from	objects	within	your	document.To	use	it,	select	the	object	containing	the	desired	color.	Open	the	Color	panel	and	click	the	Pantone	Color	Finder	icon.	Use	the	dropper	to	sample	the	color,	and	the	closest	matching	Pantone
color	will	automatically	be	displayed.4.	Use	the	Recolor	Artwork	ToolYou	can	also	convert	non-Pantone	colors	in	your	document	to	their	closest	Pantone	match	all	at	once.	Select	the	artwork	and	navigate	to	Edit	>	Edit	Colors	>	Recolor	Artwork.	In	the	Recolor	Artwork	window,	under	Recolor	with	select	Pantone	Solid	Coated	to	convert	to	the	nearest
Pantone	colors.Tips	for	Working	with	Pantone	ColorsHere	are	some	handy	tips	and	best	practices	for	working	with	Pantone	colors	in	your	Illustrator	workflow:Check	your	document	CMYK	setup	For	accurate	printed	results,	choose	a	standard	print	CMYK	profile	like	Coated	FOGRA39.Avoid	RGB	colors	RGB	has	a	much	wider	gamut	than	CMYK,	so
conversions	can	cause	unwanted	color	shifts.Use	spot	colors	for	logos	and	branding	elements	This	preserves	accuracy	when	color	separating	for	print.Dont	rely	solely	on	your	monitor	Screen	displays	cant	perfectly	match	printed	Pantone	colors.Get	physical	proofs	Use	a	printed	proof	to	verify	Pantone	colors	convert	accurately.Communicate	specs
Make	sure	vendors	know	if	a	file	uses	Pantone	colors.Add	Pantone	callouts	manually	You	can	label	objects	with	the	Pantone	number	for	easy	reference.Frequently	Asked	QuestionsWhat	is	the	difference	between	Pantone	Coated	and	Uncoated?Pantone	Coated	refers	to	colors	intended	for	printing	on	coated	paper	stock.	Coated	paper	has	a	smooth,
glossy	finish.	Pantone	Uncoated	is	for	uncoated	paper,	which	is	more	matte	and	textured.How	many	Pantone	colors	are	there?The	Pantone	Matching	System	currently	includes	1,907	solid	colors.	There	are	also	various	speciality	libraries	such	as	pastels,	neons,	and	metallics	available.Do	I	need	to	purchase	a	Pantone	swatch	book?Its	not	strictly
required,	since	Illustrator	includes	the	digital	Pantone	Solid	Coated	library.	However,	many	designers	prefer	having	the	physical	swatches	for	accurate	color	reference	and	inspiration.What	is	a	Pantone	color	bridge	book?A	color	bridge	book	shows	the	closest	CMYK,	RGB,	and	HTML	equivalents	for	each	Pantone	color.	This	is	useful	for	converting	a
Pantone	color	to	work	digitally	on	screen.Can	I	convert	Pantone	to	CMYK	in	Illustrator?Yes,	you	can	convert	Pantone	spot	colors	to	process	CMYK.	Go	to	Edit	Colors	>	Edit	Color	>	CMYK	to	convert	selected	Pantone	colors	to	CMYK	values.How	accurate	are	Pantone	to	CMYK	conversions?Converting	Pantone	to	CMYK	causes	some	loss	of	accuracy
since	CMYK	has	a	smaller	gamut.	Minimize	conversions	and	use	spot	colors	when	possible	for	maximum	accuracy.ConclusionUsing	Pantone	colors	in	your	Illustrator	work	gives	you	precision,	consistency,	and	access	to	an	enormous	spectrum	of	professional,	industry-standard	colors.	By	leveraging	the	built-in	Pantone	libraries	and	color	tools,	you	can
easily	incorporate	any	Pantone	shade	into	your	designs	and	illustrations	with	just	a	few	clicks.Remember	to	communicate	Pantone	specifications	with	your	print	provider,	get	physical	proofs,	and	minimize	unnecessary	conversions	between	color	spaces.	Used	effectively,	Pantone	colors	will	take	your	Illustrator	projects	to	the	next	level	of	color	fidelity
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